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Getting Started 

A Note from John Murphy 
Dear Fellow Trader: 
When I was first contacted by Equis to create a set of tools that 
identify chart patterns, I was quite skeptical. My roots go back to 
the old school, and the old school teaches that technical analysis, 
particularly chart patterns, are subjective. Often we refer to 
technical analysis as an "art" rather than an exact science. 
However, I'm the first to admit that computers have taken 
technical analysis to levels of efficiency in recent years that were 
previously unheard of. Sophisticated computer software has 
evolved over the last two decades that allows any aspiring 
technician to hit the ground running full-speed. 
In my book. Technical Analysis of the Financial Markets, I discuss 
two types of technicians: traditional chartists and statistical 
technicians. Traditional chartists almost exclusively use charts to 
identify their trades. The term "art charting" is often used to 
describe this approach because chart reading is largely an art 
and quite subjective. 
On the other hand, the proliferation of computers over the last two 
decades has spawned a new breed of technicians. I've labeled 
these statistical technicians. Statistical technicians take raw price 
data (i.e., open, high, low, close, volume, and open interest) and 
then crunch it to arrive at objective buy/sell signals. Human 
emotion and subjectivity are enemies to the statistical technician, 
so he attempts to remove these enemies by developing a 
computerized, mechanical trading system. Statistical technicians 
may or may not use price charts in their work. 
The traditional chartist relies on visual interpretation, while the 
statistical chartist relies on mathematical interpretation. Since the 
computer is so adept and speedy at performing accurate 
mathematical calculations, it is little wonder that the growth in the 
number of technical indicators over the last two decades has 
been tremendous. The old standbys, RSI, Stochastics, 
Momentum, and others still serve us well. However, new books 
hit the shelves regularly touting new indicators and trading 
methods. Industry periodicals come out monthly introducing the 
latest indicators. New versions of today's popular charting 
software, including MetaStock, provide dozens of the latest new 
indicators. These are all great, and have undoubtedly improved 
the perception and effectiveness of technical analysis. However, 
with all of these new indicators come confusion. Confusion leads 
to poor decisions. Poor decisions in the markets lead to lost 
money. Lost money leads to... well, you can fill in the rest.  
This leads me back to my original concern. Chart patterns are 
"visual," and highly subjective, right? If anything in technical 
analysis is an art, it is the interpretation of chart patterns. 
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However, the people at Equis International (the makers of 
MetaStock), showed me that much of what defines a chart pattern 
is indeed mathematically quantifiable with their software. They 
pointed out that my book includes sections where each pattern is 
explicitly defined along with setups, breakouts, price projections, 
etc. In fact, the folks at Equis were quick to point out that what is 
written in my book is simply high-level programming code. They 
call it "pseudo-code". Most of the rules are all there. It was just a 
matter of putting the rules into a language that the computer 
understands. This was not an easy task. This product has been in 
development for almost a year. It took much longer than we 
initially thought. 
Is the product perfect? No. Does it find every conceivable chart 
pattern that you would spot with your own eyes? No. In fact, 
some of the example patterns that I label on stock charts in my 
book are not found by the Chart Pattern Recognition tool (CPR). 
Do the chart patterns that CPR finds always lead to profitable 
trades? No. Nonetheless, given (he recognized weaknesses of 
CPR, it does a surprisingly good job at finding chart patterns. 
Will this product enhance your trading profits? Yes. But only if you 
recognize CPR's inherent liabilities and use the tools judiciously. I 
firmly believe that one can take CPR and trade effectively from it 
alone, or in conjunction with other trading methodologies. 
I hope you learn to benefit from these tools. The folks at Equis 
have done a great job at helping me apply these classical 
technical analysis trading techniques to MetaStock. The creation 
of CPR has strongly supported my faith in technical analysis and 
particularly chart patterns. I look forward to future versions of 
CPR that build and improve on what has been started. 

 

 

Sincerely, 

 

 

John Murphy 

 President of Murphy Morris.corn 
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About John Murphy 
 

John Murphy is the technical analyst for CNBC-TV. He has been a 
professional analyst for over 25 years and is author of three books. His first 
book. Technical Analysis of the Futures Markets (New York Institute of 
Finance/Prentice Hall, 1986) is widely regarded as the standard reference 
on technical analysis and has been translated into eight languages. It has 
just been released in a new edition and renamed Technical Analysis of the 
Financial Markets. Intermarket Technical Analysis (John Wiley & Sons, 
1991) is credited with creating a new branch of market analysis 
emphasizing market linkages. His latest book. The Visual Investor (John 
Wiley & Sons, 1996) was written for the individual investor and emphasizes 
sector analysis and mutual fund investing. 
John is also president of MURPHYMORRIS.COM, which was created to 
produce educational software products and online services for investors. 
John is a frequent speaker at financial conferences, and is frequently 
quoted in the financial media. In addition to frequent CNBC-TV 
appearances, he has also been interviewed on the Nightly Business Report 
and CNN's Moneyline. He was given the first award for contribution to 
global technical analysis at the Fifth World Congress of the International 
Federation of Technical Analysts in 1992. 

About MurphyMorris.Com 

 
The following was taken straight from John Murphy's and Greg Morris' 
website, www.murphymorris.com. 
OUR MISSION.. .We thought it a good time to restate our mission at 
Murphy'Morris. Our work is based primarily on technical analysis. One of 
our principal goals is education. That's why we explain what we see in the 
charts as we go along. To fill out your education, we provide books, 
CD-Roms, videotapes, recommended reading lists, and access to charting 
software. We provide you with analytical charts (like Breadth, Sector, 
Industry Group, and Intermarket Charts). And, we've started doing 
seminars. If we are in your area, we would love to meet you. We link to 
other technical websites that we like - many of which provide free charting 
capabilities. We also respond to technical questions in our Members 
Forum. Our second mission is analytical. We don't hype anything. We try to 
focus on what we think is most important in the financial markets. 
Sometimes that means an overall market view. At other times, our focus 
turns to sector rotation and individual stock selection. We examine 
intermarket influences when we feel that's appropriate. We believe our job 
is to screen through all of the market noise, figure out what's really 
important, and present our views of emerging trends to you. As one well-
known clothing manufacturer says in their advertising slogan: "An educated 
consumer is our best customer." The more you know about technical 
analysis, the more value you'll get from our service. We like to think of 
ourselves as a portal, or gateway, into the world of technical analysis. 
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There's something here for every level of technical knowledge. And, if you 
need to learn more about technical analysis, we provide lots of ways to help 
you do that too; just browse through our products and services pages at 
www.murphymorris.com. 

 

What is a Chart Pattern? 

 
In the world of technical analysis, right next to support/resistance and 
trendlines, chart patterns are a core building block. Some outsiders to 
technical analysis consider this realm of technical analysis to be so esoteric 
and "mystical" that it turns them off. This is very unfortunate, because the 
principles at work in the formation of these chart patterns are simply a 
reflection of good ole' Econ 101 supply and demand. 
Perhaps it is the names that are attached to these patterns that give cause to 
the skeptical eye. If the Head & Shoulders pattern was renamed to something 
"academic" sounding like the "Demand/Supply Transition" pattern, it may be 
more acceptable. 
One of the tenets of technical analysis is that markets trend. It has been 
observed that during the course of trend formation and trend reversal, prices 
often move in a repeatable, predictable fashion. These observed price 
movements that occur during trend formation and during trend reversals have 
been labeled and given names. These are what we call chart patterns. 
CPR (John Murphy - Chart Pattern Recognition) identifies six classical trend 
reversal patterns and three classical trend continuation patterns. The trend 
reversal patterns include: Head & Shoulder Tops, Head & Shoulder Bottoms, 
Triple Tops, Triple Bottoms, Double Tops, and Double Bottoms. The trend 
continuation patterns include: Symmetrical Triangles, Ascending Triangles, 
and Descending Triangles. 

Do Chart Patterns Really Work? 

 
Actually, this is like asking whether the economic forces of supply and demand 
really work. Or whether or not, human beings exhibit predictable, repeatable 
behavior. The answer to all of these is a resounding, "yes". And interestingly, 
chart patterns are nothing more than the principles of supply and demand at 
work, with a healthy dose of human fear and greed. 
For example, the Head & Shoulders pattern is probably the best known and 
most reliable of all major reversal patterns. As the name implies, the pattern 
forms what appears like a "head" with a left and right "shoulder." The Head & 
Shoulders Top is formed quite logically if you think about it. The completion of 
an uptrend completes the left shoulder and left-half of the head, whereas the 
beginning of a downtrend completes the right-half of the head and the right 
shoulder. A Head & Shoulders pattern, therefore, signals a change in trend. 
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Does the Head & Shoulders pattern ever fail? Of course it does. All 
patterns fail at times. But fortunately, built into every valid chart pattern are 
quantifiable stop loss points and price projections. The nine patterns in 
CPR are among the most time-tested and reliable. When CPR identifies a 
pattern, the Expert Commentary will instruct you precisely where to place 
protective stops, and what the expected price move is. The Expert 
Highlights clearly mark and label the patterns for visual inspection on your 
chart. The Expert Alerts warn you when an entry or exit position is 
warranted. And the Explorations allow you to quickly screen through 
thousands of securities looking for patterns, entry signals, and exit signals. 
CPR attempts to remove the enemy to statistical technical analysis (i.e., 
subjective human emotion), and allow you to objectively incorporate chart 
patterns into your trading strategies. 
Is it recommended that you follow these signals blindly, without 
incorporating your own judgement and experience? Absolutely not. This 
product has not matured enough to do this. Maybe there will come a day. 
But as you will see as you learn to use these tools, chart patterns can 
make significant improvements to your trading. 
 
 
 

Human Subjectivity vs- Computer Objectivity 

 
In the note at the beginning of this manual, John Murphy alluded to the 
difficulty in creating this product. Bottom line-it is no easy task to teach a 
computer software program to recognize chart patterns. It is no wonder that 
there is so little competition in this market. 
Ask any technician to identify a Head & Shoulders pattern, and he can 
quickly scan a few charts and find one. Ask him to mathematically define 
the same pattern, and he'll struggle. He can tell you what the pattern looks 
like in general terms, but to nail him down on specifics will present 
obstacles. For example, what constitutes an uptrend that is required to 
precede the Head & Shoulders pattern? How tall are the shoulders 
compared to the head? How close in height do the left and right shoulders 
have to be? How long does it take for the pattern to develop? Etc. Etc. And 
here is the biggest challenge; how strict or loose are these qualifications 
once you've defined them? There has to be some slack in the rules or all 
but the most textbook patterns will be found. 
To say that CPR is completely objective is actually a bit misleading. CPR 
simply applies John Murphy's Pattern Recognition rules and John's rules 
are based on classical pattern interpretation techniques. In a sense this 
makes the rules subjective. However, these rules become objective in that 
they are consistently applied each and every time. The human eye 
identifies a specific pattern as a Head & Shoulders one day and a Triple 
Top the next. This will never happen with CPR. CPR objectively and 
consistently applies the same rules every time. 
Are the rules perfect? No. John Murphy himself is the first to admit that 
there is plenty of room for improvement. In fact, you could even say that 
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many technicians do a better job at correctly identifying patterns than CPR. 
However, these same technicians can still benefit from CPR. They can use it 
to quickly screen thousands of charts for patterns. They can then apply their 
own expert eye to the identified patterns. Therefore, as said before, most 
technicians will benefit from the objectivity introduced in CPR, and could see 
dramatically improved trading results. 
 

Installation 
 

To install the CPR tools: 
 

1. Insert the Program CD into your drive. The setup starts automatically. 
 
Or if the auto-run feature of Windows isn't enabled on your system, click the 
Start button and choose the Run command. Type "D:\SETUP.EXE" in the 
Open box and click the OK button. 
(Note that "D" represents the letter assigned to your CD-ROM drive. If your 
drive is assigned a different letter, use it instead of "D".) 
 
2. Follow the on-screen instructions. 
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Types of Chart Patterns 
 
 
Introduction 

This chapter attempts to explain in both words and pictures the two chart 
pattern categories. Trend Reversal Patterns and Trend Continuation 
Patterns, and each of the specific patterns that fall into these categories. 

Trend Reversal Patterns 
 
 
 

             Introduction 
Patterns that fall into the category of Trend Reversal Patterns include: 
Head & Shoulder Tops, Head & Shoulder Bottoms, Triple Tops, Triple 
Bottoms, Double Tops, and Double Bottoms. As the name of this category 
implies, these patterns help the technician anticipate reversals in trend. For 
starters, we must first define a trend. 
An uptrend is defined as a series of ascending peaks and troughs as 
illustrated below. 

                          
         
                               
Conversely, a downtrend is defined as a series of descending peaks and 
troughs as illustrated below. 
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The default parameters in CPR require that the major reversal patterns, Head 
& Shoulders Tops/Bottoms and Triple Tops/Bottoms, be preceded by three or 
more successive peaks and three or more successive troughs. Double 
Tops/Bottoms require that the preceding trend have two successive peaks and 
troughs. 
Changes in trend are not typically abrupt affairs. The battle between the forces 
of supply and demand take time to resolve. It is during these transition periods 
that clues in the form of Trend Reversal Patterns often appear. 
Each of the Trend Reversal Patterns that CPR identifies have certain 
measuring techniques that help the analyst determine price moves and trade 
duration after the breakout. 
 
 

                  Head & Shoulders Tops 
The Head & Shoulders Top is undoubtedly the best known and perhaps the 
most reliable of all the major reversal patterns. This pattern, like others, is 
simply a refinement of the concepts of trend. 
 
 

How the Head & Shoulders Pattern Forms 
Picture an uptrending market with successive peaks and troughs each 
reaching higher than the previous. A sign that this upward momentum is 
slowing occurs when a trough forms about equal to the preceding trough 
(rather than above it). It is at this point that one should be alert. If the next rally 
fails to rise above the previous peak, then we have the makings of a classical 
Head & Shoulders pattern. 
During the formation of this pattern, the forces of supply and demand are in 
relative balance. Once the distribution phase has completed, support along the 
bottom of the horizontal trading range (called the neckline) is broken and a 
new downtrend is established. The neckline is very often a slightly upward 
sloping to flat line. Less often it is downward sloping. This new downtrend will 
have descending peaks and troughs in the opposite direction of the trend that 
led up to the pattern. 
The illustrations below show the formation of a typical Head & Shoulders 
pattern, beginning with an uptrend and the "left shoulder." 
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After the formation of the left shoulder, prices rally higher and then retreat 
to form a "head.". 
 
 

    
 

Prices then attempt to rally once more, but fail to rise above the head 
thereby forming a "right shoulder." 

 

      

Often, after the breakout occurs, prices rally back up to the neckline (which 
now acts as upside resistance). From here, prices are expected to fall off 
and the new downtrend ensues. 

 

Summary of Rules for a CPR Head & Shoulders 
Top Pattern 
1. A prior uptrend defined as three or more successive peaks/troughs. 
2. A left shoulder, followed by a corrective dip. 
3. A rally to new highs above the left shoulder. 
4. A decline that moves below the left shoulder and approaches the 

previous trough. 
5.  A third rally that fails to reach the top of the head. 
6. A close below the neckline. 
 

Trading the Head & Shoulders Top Pattern 
The neckline of the Head & Shoulders pattern provides the trader with 
three critical pieces of information. 
1. It tells where to enter the trade (i.e., the breakout point). 
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2. It is used in the calculation of the minimum price objective for closing the 
trade. 
3. It is the basis for the stop-loss level. 

 
 

        
 
 
Once the neckline is decisively penetrated to the downside, CPR issues a sell-
short signal at the open of the next day. The minimum downside price move is 
projected by measuring the height of the head to the next trough and 
projecting this distance downward from the breakout point. The maximum 
downside price move is the low of the bar at the start of the prior uptrend. 
If the minimum price objective is not met within a specific time period or if 
prices rally above the neckline then the pattern is cancelled. The minimum 
time period for the pattern to breakout is equal to the distance from the head to 
the right shoulder projected from the right shoulder. The maximum time period 
for prices to reach the minimum price objective is equal to the distance from 
the left shoulder to the right shoulder projected from the breakout. 
The min/max price objectives and stops are provided in the Expert 
Commentary (see page 27). Expert Alerts will also pop up and alert you on the 
breakout and exit days. 
 

Head & Shoulders Bottoms 
The Head & Shoulders Bottom is simply an inverted image of the Head & 
Shoulders Top. The formation of this pattern occurs exactly the same as the 
Head & Shoulders Top pattern except it is preceded by a downtrend. It marks 
the transition period at the end of a downtrend and the beginning of an 
uptrend. 
The following illustration shows the key components of a Head & Shoulders 
Bottom. All other points about the Head & Shoulders Bottom pattern are the 
same as the Head & Shoulders Top. Refer to the Head & Shoulders Top 
section for additional information. 
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Triple Tops 
The Triple Top is a close cousin of the Head & Shoulders Top. In fact, the 
Triple Top, which is less common, is just a slight variation of the Head & 
Shoulders Top. Refer to the discussion of Head & Shoulders Tops for 
additional insight. 
 
 

How the Triple Top Pattern Forms 
A Triple Top pattern, as the name implies, occurs after an uptrend and is 
comprised of three peaks (i.e., tops) at approximately the same price level. 
Picture an uptrending market with successive peaks and troughs each 
reaching higher than the previous. A sign that this upward momentum is 
slowing occurs when the latest peak fails to rise above the previous peak 
and then falls back to around the same level as the previous trough. If the 
next rally fails to exceed the two previous peaks, then we have the makings 
of a Triple Top Pattern. 
As with the Head & Shoulders Top pattern, the forces of supply and 
demand are in relative balance. Once the distribution phase has 
completed, a support line along the lows of the horizontal trading range is 
broken and a new downtrend is established. This new downtrend will have 
descending peaks and troughs in the opposite direction of the trend that led 
up to the pattern. 
The illustration below shows the formation of a Triple Top pattern. 
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Often, after the breakout occurs, prices rally back up to the support line (which 
now acts as upside resistance). From here, prices fall off and the new 
downtrend ensues. 
 
 

Summary of Rules for a CPR Triple Top Pattern 
1. A prior uptrend defined as three or more successive peaks/troughs. 
2. A left peak, followed by a corrective dip. 
3. A rally to the same level as the left peak. 
4. A decline that approaches the previous trough. 
5. A third rally that approaches the same level as the previous two peaks. 
6. A close below the support line formed along the troughs. 
 

Trading the Triple Top Pattern 
The support line of the Triple Top pattern provides the trader with three critical 
pieces of information. 
1.  It tells where to enter the trade (i.e., the breakout point). 
2. It is used in the calculation of the minimum price objective for closing the 
trade. 
3.  It is used in the calculation of the stop-loss level. 
Once the support line is decisively penetrated to the downside, CPR issues a 
sell-short signal at the open of the next day. The minimum 
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downside price move is projected by measuring the average height of the 
three peaks to the support line and projecting this distance downward from 
the breakout point. The maximum downside price move is the low of the 
bar at the start of the prior uptrend. 
If the minimum price objective is not met within a specific time period or if 
prices rally above the neckline then the pattern is cancelled. The minimum 
time period for the pattern to breakout is equal to the distance from the 
middle peak to the right peak projected from the right peak. The maximum 
time period for prices to reach the minimum price objective is equal to the 
distance from the left peak to the right peak projected from the breakout. 
The min/max price objectives and stops are provided in the Expert 
Commentary (see page 27). Expert Alerts will also pop up and alert you on 
the breakout and exit days. 
 

Triple Bottoms 
The Triple Bottom is simply an inverted image of the Triple Top. The 
formation of this pattern occurs exactly the same as the Triple Top pattern 
except it is preceded by a downtrend. It marks the transition period at the 
end of a downtrend and the beginning of an uptrend. 
All other points about the Triple Bottom pattern are the same as the Triple 
Top. Refer to the Triple Top section for additional information. The 
following illustration shows the formation of a Triple Bottom pattern. 
 
 

 
 
 

Double Tops 
The Double Top pattern is perhaps the most frequent and easily spotted of 
all the reversal patterns. For obvious reasons, this pattern is often referred 
to as an "M" top. 
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How the Double Top Pattern Forms 
A Double Top pattern, as the name implies, occurs after an uptrend and is 
comprised of two prominent peaks (i.e., tops) at approximately the same price 
level. 
As prices trend upward with successive peaks and troughs, prices encounter 
resistance and retreat temporarily. Prices then make a final attempt to rally, 
where they again encounter resistance at about the same price level as the 
previous peak. The conclusion of the Double Top formation occurs when 
prices close below the previous trough. A return move back up to the breakout 
point is common prior to the resumption of the new downtrend. 
The charts below illustrate the formation of a typical Double Top pattern. 
 
 

 
 
 

A common mistake among technicians is to prematurely identify a Double Top 
before it is confirmed with a decisive downside breakout. What at first appears 
to be the formation of a Double Top may actually be an Ascending Triangle 
(see page 18), as shown below. The only difference is that the second 
pullback never broke below the previous trough. So instead of signaling a 
reversal, the pattern signals a continuation of the uptrend. 
 
 

 
 
 

Summary of Rules for a CPR Double Top Pattern 
1. A prior uptrend defined as at least two successive peaks/troughs. 
2. A left peak, followed by a corrective dip. 
3. A rally to the same level as the left peak. 
4. A close below the previous trough confirms the pattern. 
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Trading the Double Top Pattern 
As with the other reversal patterns, the support line of the Double Top 
pattern provides the trader with three critical pieces of information. 
1.  It tells where to enter the trade (i.e., the breakout point). 
2. It is used in the calculation of the minimum price objective for closing the 

trade. 
2. It is used in the calculation of the stop-loss level. 

 
Once the support line is decisively penetrated to the downside, CPR issues 
a sell-short signal at the open of the next day. The minimum downside 
price move is projected by measuring the height of the first top to the 
support line and projecting half of this distance downward from the 
breakout point. The maximum downside price move is the low of the bar at 
the start of the prior uptrend. 
 
 
 

 
 
 

If the minimum price objective is not met within a specific time period or if 
prices rally above the neckline then the pattern is cancelled. While classical 
chart pattern analysis does not suggest this (only CPR), the minimum time 
period for the pattern to breakout is equal to the distance from the first peak 
to the second peak projected from the second peak. The maximum time 
period for prices to reach the minimum price objective is equal to the 
distance from the first peak to the second peak projected from the breakout 
point. 
The min/max price objectives and stops are provided in the Expert 
Commentary (see page 27). Visual and audible Expert Alerts will also pop 
up and alert you on the breakout and exit days. 
 

Double Bottoms 
The Double Bottom is simply an inverted image of the Double Top. The 
formation of this pattern occurs exactly the same as the Double Top pattern 
except it is preceded by a downtrend. It marks the transition period at the 
end of a downtrend and the beginning of an uptrend. 
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All other points about the Double Bottom pattern are the same as the Double 
Top. Refer to the Double Top section for additional information (see page 13). 
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Continuation Patterns 
 

Introduction 
Patterns that fall into the category of Trend Continuation Patterns include: 
Ascending Triangles, Descending Triangles, and Symmetrical Triangles. 
As the name of this category implies, these patterns help the technician 
anticipate a continuation of the prevailing trend. See page 35 for a 
definition of trend. 
Although the odds of prices breaking out of the Symmetrical Triangle 
pattern in the direction of the prevailing trend are greater, prices sometimes 
break out against the trend. In these instances, the pattern acts as a trend 
reversal pattern. 
The default parameters in CPR require that the continuation patterns be 
preceded by two or more successive peaks and two or more successive 
troughs. Changes in trend are not typically abrupt affairs. The battle 
between the forces of supply and demand take time to resolve. However, 
continuation patterns usually take less time to develop than reversal 
patterns and therefore are more accurately defined as short- or 
intermediate-term patterns. 
As with the trend reversal patterns, the continuation patterns that CPR 
identifies have certain measuring techniques that help the analyst 
determine price moves and trade duration after the breakout. 
All three triangle patterns have three common elements: the base, apex, 
and a minimum of four reversal points. The far left of the triangle pattern is 
called the base. The base marks the beginning of the pattern and is the 
widest point. The height of the pattern, which is used in determining the 
price move objectives, is measured at the base. The apex marks the 
intersection of the trendlines drawn along the peaks and troughs. All 
triangle patterns require at least two peaks and two troughs. 
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Ascending Triangles 
The Ascending Triangle is a bullish pattern that marks a pause in an uptrend 
as the forces of supply and demand eventually resolve in favor of "demand" 
before resuming the bullish uptrend. 
 
 

How the Ascending Triangle Pattern Forms 
The Ascending Triangle pattern has a rising lower line along the troughs 
with a flat upper line along the peaks. Ascending Triangles are usually 
preceded by an uptrend with the uptrend having at least two successive 
peaks and two successive troughs. 
 
 

 
 
 
 

As prices trend upward with successive peaks and troughs, prices 
encounter resistance and retreat temporarily. Each of the troughs in price, 
however, occurs at successively higher levels. The conclusion of the 
Ascending Triangle pattern occurs when prices close above the resistance 
line along the peaks. The prevailing uptrend then typically continues. 
A common mistake among technicians is to prematurely identify a Double 
Top as an Ascending Triangle. What at first appears to be the formation of 
an Ascending Triangle actually ends up being a Double Top (see page 13), 
as shown below. The only difference is that the final pullback in the Double 
Top breaks below the previous trough. So instead of signaling a continuation 
of uptrend, the pattern signals a reversal of the uptrend. 
 

 
 

Summary of Rules for a CPR Ascending Triangle 
Pattern 
1. A prior uptrend defined as at least two successive peaks/troughs. 
2. A left peak, followed by a corrective dip. 
3. A rally to the same level as the left peak. 
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4. A correction dip, forming a second trough above the previous trough. 
5. A rally above the previous peak causing a breakout. 
Trading the Ascending Triangle Pattern 
Once the resistance line along the peaks is decisively penetrated to the 
upside, CPR issues a buy signal for the open of the next day. 
If prices do not breakout to the upside before moving 75% of the distance 
from base to apex, then the pattern is cancelled. Or if prices close below 
the lower trendline, the pattern is cancelled. After an upside breakout, the 
minimum time period for the price objective to be met is equal to the 
distance from the midpoint of the first peak or trough to the midpoint of the 
second peak or trough. The price objective is equal to one-half the height 
of the base projected upward from the breakout point. 
 
 
 
 
 

Descending Triangles 
The Descending Triangle is a bearish pattern that marks a pause in a 
downtrend as the forces of supply and demand eventually resolve in favor 
of "supply" before resuming the bearish downtrend. 

How the Descending Triangle Pattern Forms 
The Descending Triangle pattern has a falling upper line along the peaks 
with a flat lower line along the troughs. Descending Triangles are preceded 
by a downtrend with at least two or more successive peaks and two or 
more successive troughs. 
 
 

 
 
 

As prices trend downward with successive peaks and troughs, prices 
encounter support and rally temporarily. Each of the rallies in price, 
however, occurs at successively lower levels. The conclusion of the 
Descending Triangle pattern occurs when prices close below the support 
line along the troughs. The prevailing downtrend then typically continues. 
A common mistake among technicians is to prematurely identify a Double 
Bottom reversal as a Descending Triangle. What at first appears to be the 
formation of a Descending Triangle actually ends up being a Double 
Bottom (see page 15), as shown below. The only difference is that the final 
rally in the Double Bottom breaks above the previous peak. 
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So instead of signaling a continuation of the downtrend, the pattern signals 
a reversal of the downtrend. 
 
 

 
 

Summary of Rules for a CPR Descending 
Triangle  Pattern 

 
1. A prior downtrend defined as at least two or more successive 
peaks/troughs. 
2. A left trough, followed by a corrective rally. 
3. A dip to the same level as the left trough. 
4. A correction rally, forming a second peak below the previous peak. 
5. A dip below the previous trough causing a breakout. 
 

Trading the Descending Triangle Pattern 
Once the support line along the troughs is decisively penetrated to the 
downside, CPR issues a sell signal at the open of the next day. 
If prices do not breakout to the downside before moving 75% of the 
distance from base to apex, then the pattern is cancelled. Or if prices close 
above the upper trendline, the pattern is cancelled. After a downside 
breakout, the minimum time period for the price objective to be met is 
equal to the distance from the midpoint of the first peak or trough to the 
midpoint of the second peak or trough. The price objective is equal to one-
half the height of the base projected downward from the breakout point. 
 
 
 
 
 

Symmetrical Triangles 
 

The Symmetrical Triangle is usually a continuation pattern that marks a 
pause in the trend. The forces of supply and demand usually resolve in 
favor of the direction of the prevailing trend. 
 

How the Symmetrical Triangle Pattern Forms 
The Symmetrical Triangle pattern has a falling upper line along the peaks 
and a rising lower line along the troughs. The height of each of the 
peaks/troughs must be between 60% and 90% of the height of the first 
peak/trough (i.e., the base). 
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In the case of a Symmetrical Triangle during an uptrend, prices trend 
upward with successive peaks and troughs. Prices encounter resistance 
and pull back temporarily. Each of the troughs in price, however, occurs at 
successively higher levels, whereas each of the peaks occurs at lower 
levels, thereby forming a symmetrical triangle. The conclusion of the 
Symmetrical Triangle pattern occurs when prices close either below the 
support line along the troughs (odds favor this during a downtrend), or 
when prices close above the resistance line along the peaks (odds favor 
this during an uptrend). 
 

Summary of Rules for a CPR Symmetrical 
Triangle Pattern 

 
1. A prior uptrend or downtrend defined as at least two or more successive 
peaks/troughs. 
2. A left peak (trough), followed by a corrective dip (rally). 
3. A rally (dip) below (above) the level of the left peak (trough). 
4. A correction rally (dip), forming a second peak (trough) below (above) 
the previous peak (trough). 
5. A decisive move above (below) the trendline along the peaks (troughs). 
 

Trading the Symmetrical Triangle Pattern 
 

If the resistance line along the peaks is decisively penetrated to the upside, 
CPR issues a buy signal at the open of the next day. If the support line 
along the troughs is penetrated to the downside, CPR issues a sell-short 
signal at the open of the next day. 
If prices do not breakout before moving 75% of the distance from base to 
apex, then the pattern is cancelled. After a breakout, the minimum time 
period for the price objective to be met is equal to the distance from the 
midpoint of the first peak or trough to the midpoint of the second peak or 
trough. The price objective is equal to one-half the height of the base 
projected from the breakout point. 
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Turning Chart Patterns into Trading 
Profits 
 
 
 
Introduction 

 
In this chapter, you are shown how to use the CPR tools to make money in 
the markets. A certain level of familiarity with MetaStock is expected. At a 
bare minimum you must be proficient with the techniques covered in the 
MetaStock Getting Started manual. You should also be familiar (at least in 
concept) with the MetaStock Formula Language, the Explorer, and the 
Expert Advisor covered in the MetaStock User's Manual. 
Every trader's goal is to make money in the markets. Chart patterns can be 
used to enhance your success in this goal. However, you'll need to invest 
some time in learning the software, developing a routine, and practicing 
good money management. There is a lot of good information on money 
management techniques on the Internet. You can also refer to John 
Murphy's book Technical Analysis of the Financial Markets for excellent 
coverage of this topic. 

The daily routine that is recommended for using these tools is as follows: 
1. Screen through your stock folders using the CPR explorations. 
2. Apply the CPR Experts to the top chart candidates. 
3. View the CPR Expert Commentary. 

 
 

Step 1 - Screening for Patterns using the CPR Explorations 
 

The Explorer, included with MetaStock, is perhaps the most time-saving 
tool in the software. With the Explorer you can quickly filter through 
thousands of securities looking for the few that meet your pre-defined 
criteria. In the case of the CPR explorations, you will quickly be able to find 
those stocks that have formed a pattern and are showing an unconfirmed 
entry signal and/or are breaking out of a pattern and thereby issuing a 
confirmed entry signal. These explorations are really the starting point and 
primary tool used for your analysis. 

Turning Chart Patterns into Trading Profits • 23 
 
 



CPR includes two explorations that produce these reports: 
John Murphy - Confirmed Entry Signal  
John Murphy - Unconfirmed Entry Signal 

 
 
 

These explorations are primarily intended to be run on daily data. 
However, they will work on other periodicities as well—including real-time 
(with the exception of tick data). 
 
 
Screening Securities for Potential Trades 
The exploration named "John Murphy - Confirmed Entry Signals" filters 
through your securities and lists those securities that have broken out on 
the close of the most recent trading day (assuming your data is up-to-( 
date). 

To screen your securities for confirmed entry 
signals 
1. Run MetaStock. 
2. Choose The Explorer from the Tools menu. 
3. Click the Options button in The Explorer dialog. Make sure that you 
have "Load <500> records" selected. Click the OK button. 
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4. Select "John Murphy - Confirmed Entry Signal from The Explorer dialog.       
Click the Explore button. 
5. Choose the MetaStock data folder(s) you wish to screen from the Select 
Securities dialog. Click the OK button. 
6. After the exploration completes, click the Reports button. 
7. Select all of the securities (if any) in the report and click the Open Chart    
button. 
8.  Click on the desired chart to analyze. 
9. Choose Expert Advisor from the Tools menu. Select "John Murphy - 
Chart Pattern Recognition" from the Expert Advisor dialog. Click the 
Attach button. See the following section for more details on applying 
experts to charts. 
 
 

 
 
 

10. Choose Expert Commentary from the View menu. Repeat steps 8 
through 11 for each open chart. See page 27 for more details on viewing 
expert commentaries. 
11. Based on your study of the Expert Commentaries and your own 
additional analysis and judgement, choose the best security(s) to place an 
entry trade. 
 
 
 
 

Step 2 - Applying Experts to Charts 
 

MetaStock's Expert Advisor feature allows you to receive chart specific 
feedback in a variety of ways. The experts included with the CPR tools 
provide you with four different types of feedback. First, when attached to a 
chart, the expert colors all price patterns found on the chart using Expert 
Highlights. Second, the expert places Expert Symbols above or below 
each bar where either an entry or exit signal is generated. Third, an alert 
will pop up when either an entry or exit signal is generated.  And       fourth, 
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you can view Expert Commentary that provides actual English-language 
advise on breakouts, price objectives, time objectives, and stops. Note that 
details on this fourth method are covered in the next section. 
 
 
 
 
 
Viewing Charts for Potential Trades 

 
The expert named "John Murphy - Chart Pattern Recognition" highlights 
the patterns on the chart, places symbols at the entry and exit points, and 
pops up trade alerts. Even though the explorations and expert 
commentaries provide you with specific details on which stocks to 
consider, it is important that you visually analyze the charts and apply your 
own unique judgement prior to actually placing a trade. 
 
 

CPR in Real-time 
Note that the CPR experts can be attached to any chart, including those 
updating in real-time with MetaStock Professional. However, if you attach 
the CPR expert to a real-time chart, you should disable live bars to ensure 
accurate results. To disable live bars, choose Options from the Tools menu 
in MetaStock Pro, then click the Real-time tab. Uncheck the "Enable Live 
Bars" checkbox. 
 
 
 

 
 
 

To view a chart for potential trades 
1. Run MetaStock. 
2. Choose Open from the File menu. Open a chart. 
3. Choose Expert Advisor from the Tools menu. 
4. Select "John Murphy - Chart Pattern Recognition' from the Expert 
Advisor dialog. Click the Attach button. 
5. If any of the nine chart patterns are found in the chart, they will be 
highlighted. All entry/exit signals will also be placed on the chart. If an 
entry/exit signal exists for the last day in the chart, then an alert will pop 
up. 
6. Based on your study of the Expert Commentaries (see the following 
section) and your own additional analysis and judgement, decide if a trade 
should be placed with the security. 
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Step 3 - Viewing the CPR Expert Commentary for Specific 
Entry/Exit Points 

The Expert Commentary included with CPR provides you with English 
language advice on a specific chart for the following: 
 

•   The type of pattern that has formed (if any) for the selected day on the chart. 

•   If a chart pattern has formed but no breakout has yet occurred. 
•   Where the breakout point is located. 
•   If an entry signal has been issued. 
•   Where to enter and exit your trades. 
•   Minimum and maximum price objective for the buy/short position. 
•   The time frame for the price objective to be met. 
•   Where to place protective stops. 
 

To view a chart's Expert Commentary 
1. Run MetaStock. 
2. Choose Open from the File menu. Open a chart. 
3. Choose Expert Advisor from the Tools menu. 
4. Select "John Murphy - Chart Pattern Recognition' from the Expert Advisor 

dialog. Click the Attach button. 
5. Choose Expert Commentary from the View menu. 
6. To get feedback on a bar other than the last bar on the chart, simply click 

the mouse above/below the desired bar. For example, you may want to 
see feedback on the bars at the end of the most recent highlighted chart 
pattern, or perhaps on the day of the last entry/exit point. 
The expert commentary below was generated for Bell Atlantic on 
12/27/1999. As you can see, it provides specific advice on the pattern, and 
how to place and monitor a trade. 
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An Actual Trading Scenario using CPR 
 
 

For our actual trading scenario we simply followed what would be a typical 
post market hours process that you would likely go through. The date of 
the analysis that we are performing this process is 01/03/2000. 
 
 
Step 1: Update the Data using The DownLoader 

 
The first thing we did at the end of the market day on 01/03/2000 was to 
update our security files using The DownLoader software. The signals that 
MetaStock generates will only be as accurate and timely as your data is 
accurate and timely. We updated two folders containing all optionable 
stocks—some 2.968. (An optionable stock is a stock on which option 
contracts are issued.) This seems to be a good representation of the most 
actively traded stocks. 

 
 

 

 
 
 
See your DownLoader User's Manual for detailed information on updating 
your security files. 
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Step 2: Run the CPR Exploration 
 

As mentioned earlier, the explorations are the heart and soul of the CPR 
tools. This is where we recommend you begin, and where you can quickly 
cut right through to those few securities that are showing potential trading 
opportunities. 
First, on 02/03/2000 the exploration named "John Murphy - Confirmed 
Entry Signal" was run to find those securities showing confirmed buy/short 
opportunities. After running the exploration, the following results were 
shown in the exploration report. 
 
 

 
 
 
Note that only eight of the 2,968 securities are showing confirmed signals 
for 02/03/2000. 
 
 
Step 3: Study the Charts 

 

After filtering our universe of 2,968 stocks down to just a few that are 
showing actual trading signals, it is now time to visually inspect each chart. 
After visually inspecting each of the eight charts, we narrow the choice 
down to two—Rayonier and Trimeris. We feel uncomfortable with the 
remaining six because of a lack of a visually appealing patterns (a 
subjective determination), or the lack of volume surrounding the breakout 
signals. 

Rayonier is showing a Double Top sell signal. You know this from the 
Exploration report from the -1.0000 appearing in the Double T/B column (a 
1.0000 would indicate a Double Bottom buy signal). Our visual inspection 
of Trimeris is somewhat mixed. While the volume on the breakout day is 
impressive, the pattern itself (while mathematically a double top) is not that 
attractive from our subjective viewpoint. 
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Trimeris is showing a Symmetrical Triangle buy signal. You know this from 
the Exploration report from the 1.0000 appearing in the Sym Tri column (a 
-1.0000 would indicate a sell signal). The volume on the breakout day is 
impressive, and the pattern itself is also quite impressive, with a nice 
uptrend leading into about a four month consolidation period marked by 
the Symmetrical Triangle. Also of note is that the breakout also took out 
the previous September high. 
 
 
 

 
 
 

Step 4: View the Expert Commentary 
Now let's take a look at what the expert commentary has to say about the specifics of each 
chart's signal. 
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Although the visual inspection of the Double Top pattern is suspect, the 
commentary shows decent potential with a maximum downside of over 10 
points (or 22%). 

 

 
 

The commentary for Trimeris shows decent profit potential as well with a 
maximum upside of over six points (or 24%). 
 
 
 
 
 
Step 5: Evaluate the Trading Opportunities 

 
Based on our analysis in the previous steps, we will need to prioritize 
which security to trade. After closely inspecting both Rayonier and 
Trimeris, we conclude that Trimeris is the most attractive for the following 
reasons: 1) The pattern is more visually appealing,      2) the volume on the 
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breakout day is impressive, 3) the profit potential is large, and 4) a 
previous high in September is taking out with the breakout. 
To help our visual monitoring of the trade, let's draw some lines on the 
chart at the minimum price objective, the maximum price objective, and the 
stop-loss value. With MetaStock's Smart Chart feature, these lines and 
notations will remain on the chart from day to day. 
 
 

 
 
 

Step 6: Place the Trade 
 

All entry and exit signals that CPR generates are designed to be placed at 
the open of the next trading day—in this case at the open of trading on 
01/04/2000. This is convenient since it allows us to do our analysis in the 
calm of the post-market evening hours, make our decision, and then place 
a market order with our broker for execution at the open of the next trading 
day. 
The following illustration shows a typical online broker order ticket as it 
may be filled out for this trade with Trimeris (ticker: TRMS). 
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Step 7: Monitor Your Open Trade 
Now that the analysis has been done, the decision made, and the trade 
entered, the real work begins. We must now keep a close eye on the chart 
in order to maximize our profits and/or limit our losses. Each evening, we 
must open an updated chart of Trimeris with the CPR expert attached. We 
want to make sure the CPR expert is attached to the chart because it will 
alert us when to close the trade. 
The three horizontal lines that we drew at the three key price points in step 
3 also help us monitor the development of the trade. 
 
 
 
 
 

Hypothetical Results on the S&P 100 Stocks 

 
In an attempt to give users an idea of the potential effectiveness of the 
CPR chart patterns and their accompanying signals, a non-scientific study 
was done on the 100 stocks comprising the S&P 100 Index. Only the 
100% objective raw patterns and their accompanying signals were used to 
calculate the results. No additional indicators, trailing stops, or visual 
inspection were employed to aid profitability. 
In order to get an accurate representation of how the patterns performed 
under various market conditions, we studied three different time periods on 
the S&P 100 stocks: 1990, 1994, and 1999. 1990 was quite volatile, with 
the index ending the year down 7.6%. 1994 was relatively low in volatility 
and almost exactly flat for the year. 1999 was also quite volatile with the 
index ending the year up 31%. 
The tables below show the number of good and bad signals generated for 
each pattern during 1990, 1994, and 1999. The last table shows the 
combined totals for the three years. A signal was considered "good" if it 
showed a profit at the minimum price objective (if met). A signal was 
considered "bad" if it showed a loss by being stopped or timed out. 
As mentioned earlier, this test was very unscientific. Nevertheless, good 
backtesting techniques were used to obtain the results. Some 54% of the 
raw signals were profitable. Undoubtedly, dramatic improvements can still 
be made. The most obvious area to look at to improve the signals is to 
combine these raw chart pattern signals with signals from other systems or 
indicators, use trailing stops, and practice good money management 
techniques. 
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1990 Test Results 
 

 
 
 
 

1994 Test Results 
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1999 Test Results 
 
 

 
 
 
 
1990,1994,1999 Combined Test Results 

 

 
 
 

Definition of Trading Terms 
Bearish. A negative sentiment for market prices.  

Bullish. A positive sentiment for market prices. 

Buy-stop. A buy order placed with a broker that will be held until the 
market price rises to the stop price, at which point a market order is 
automatically entered. A buy-stop order is usually placed to protect a profit 
or limit a loss on a short sale. It can also be used to open a new long 
position at a specified price. 
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Long. The purchase of a security with the anticipation of selling it at a 
higher price, thereby generating a profit. 
 
Sell stop. A sell order placed with a broker that will be held until the 
market price falls to the stop price, at which point a market order is 
automatically entered. A sell-stop order is usually placed to protect a profit 
or limit a loss on a security already purchased at a higher price. It can also 
used to open a new short position at a specified price. 
 
Short. The sale of a security with the anticipation of buying (covering) it at 
a lower price, thereby generating a profit. A short position is opened by 
selling borrowed securities and closed (or covered) by buying the 
borrowed securities. 
 
Stop-loss. An order placed with a broker that sets the exit price of a stock 
at a level that will limit losses should prices move adversely. 
 
Trailing Stop. A buy stop or a sell stop that is placed with a broker in order 
to protect profits. 
 
Trend. Price movements, either up, down, or sideways which characterize 
a particular market or security. 
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Modifying the CPR Functions 
 
 
 
 
Introduction 

For those that are adventurous and have experience working with the 
MetaStock Formula Language or general programming languages, this 
section will be helpful. You must be cautioned, however, because the 
information provided in this section is quite complex and technical. This 
information allows you to make modifications to the default patterns. 
Note that Equis International and John Murphy cannot provide 
technical support for any changes that you make to the CPR tools. 
A definition of the 3 stages of chart pattern development are provided 
below to help in your understanding of the function and parameter 
definitions. 
Stage 1 - Pattern identified until breakout point 
Stage 2 - Breakout point until minimum price target met 
Stage 3 - Minimum price target met 
 
 
 

Head & Shoulders Top/Bottom  
 
 

Functions 
 

IdentifyHST/IdentifyHSB - Returns an array filled with the following 
values: 1.0 for a pattern in Stage 1, 2.0 for a pattern in Stage 2, 3.0 for a 
pattern in Stage 3, 10.0 when the pattern enters Stage 1, and 20.0 when 
the pattern enters Stage 2 from Stage 1. 
HSTProjection/HSBProjection - Returns an array filled with the following 
values starting with the bar in which the pattern enters Stage 2 and 
stepping backwards: the Stage 2 time objective, the Minimum price 
objective, the Maximum price objective, and the stop loss value. 
HSTNeckline/HSBNeckline - Returns an array filled with the values of the 
neckline at each bar between where the pattern entered Stage 1 and 
where it entered Stage 2. 
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Parameters 
 

ZigZagPercentChange — The value for the Percent Change (if 0 is 
passed in, the value will be calculated dynamically), (default = 0) 
PercentChangeMultiple — Value by which the percent change will be 
multiplied so it has a different value for each iteration through the price 
array, (default = 1.5) 
TrendCalcMethod — Specifies ZigZag method. Linear Slope method, or 
Moving Average method, (default = Z) 
TrendCalcPeriods — Specifies how many periods should be used to 
determine the current trend, (default = 3 for ZigZag, 13 for LinearSlope or 
MovingAverage) 
TrendCalcSlopeCutoff— Specifies the value for which the slope will be 
considered an uptrend. If the value were .03, for example, then only slopes 
above .03 would be considered an uptrend, (default = .03 for LinearSlope 
method, 0 otherwise) 
HeadPercentHigherVal — The percentage by which the head is higher 
than the average height of the shoulders, (default =10) 
HorizSymmetryVal — Specifies the maximum number of times greater 
that the distance between the left shoulder and head can be than the right 
shoulder and head, and vice versa. If HorizSymmetryVal is 1.5, then the 
distance between the left shoulder and the head can be no more than 1.5 
times the distance of the right shoulder and the head, and vice versa. 
(default = 1.5) 
 
 
 

Triple Tops/Triple Bottoms 
 
 

 Functions 
IdentifyTT/IdentifyTB - Returns an array filled with the following values: 
1.0 for a pattern in Stage 1, 2.0 for a pattern in Stage 2, 3.0 for a pattern in 
Stage 3, 10.0 when the pattern enters Stage 1, and 20.0 when the pattern 
enters Stage 2 from Stage 1. 
TTProjection/TBProjection - Returns an array filled with the following 
values starting with the bar in which the pattern enters Stage 2 and 
stepping backwards: the Stage 2 time objective, the Minimum price 
objective, the Maximum price objective, and the stop loss value. 
TTNeckline/TBNeckline - Returns an array filled with the values of the 
neckline at each bar between where the pattern entered Stage 1 and 
where it entered Stage 2. 
 
Parameters 
ZigZagPercentChange — The value for the Percent Change (if 0 is 
passed in, the value will be calculated dynamically), (default = 0) 
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PercentChangeMultiple — Value by which the percent change will be 
multiplied so it has a different value for each iteration through the price 
array, (default = 1.5) 
TrendCalcMethod — Specifies ZigZag method. Linear Slope method, or 
Moving Average method, (default = Z) 
TrendCalcPeriods — Specifies how many periods should be used to 
determine the current trend, (default = 3 for ZigZag, 13 for LinearSlope or 
MovingAverage) 
TrendCalcSlopeCutoff — Specifies the value for which the slope will be 
considered an uptrend. If the value were .03, for example, then only slopes 
above .03 would be considered an uptrend, (default = .03 for LinearSlope 
method, 0 otherwise) 
VerticalSymmetryVal — The maximum percentage difference that the 
head can be from the average height of the shoulders, (default =10) 
HorizSymmetryVal — Specifies the maximum number of times greater 
that the distance between the left shoulder and head can be than the right 
shoulder and head, and vice versa. If HorizSymmetryVal is 2.5, then the 
distance between the left shoulder and the head can be no more than 2.5 
times the distance of the right shoulder and the head, and vice versa. 
(default =1.5) 
 
 
 

Double Tops/Double Bottoms 
 
 

 Functions 
 

IdentifyDT/IdentifyDB - Returns an array filled with the following values: 
1.0 for a pattern in Stage 1, 2.0 for a pattern in Stage 2, 3.0 for a pattern in 
Stage 3, 10.0 when the pattern enters Stage 1, and 20.0 when the pattern 
enters Stage 2 from Stage 1. 
DTProjection/DBProjection - Returns an array filled with the following 
values starting with the bar in which the pattern enters Stage 2 and 
stepping backwards: the Stage 2 time objective, the Minimum price 
objective, the Maximum price objective, and the stop loss value. 
DTNeckline/DBNeckline - Returns an array filled with the value of the 
middle trough at each bar between where the pattern entered Stage 1 and 
where it entered Stage 2. 
 
Parameters 

 
ZigZagPercentChange — The value for the Percent Change (if 0 is 
passed in, the value will be calculated dynamically), (default = 0) 
PercentChangeMultiple — Value by which the percent change will be 
multiplied so it has a different value for each iteration through the price 
array, (default = 1.5) 
TrendCalcMethod — Specifies ZigZag method. Linear Slope method, or 
Moving Average method, (default = Z) 
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TrendCalcPeriods — Specifies how many periods should be used to 
determine the current trend, (default = 2 for ZigZag, 13 for LinearSlope or 
MovingAverage) 
TrendCakSlopeCutoff— Specifies the value for which the slope will be 
considered an uptrend. If the value were .03, for example, then only slopes 
above .03 would be considered an uptrend, (default = .03 for LinearSlope 
method, 0 otherwise) 
VerticalSymmetryVal — The maximum percentage difference that the left 
top can be from the right top. (default =10) 
HorizSymmetryVal — Specifies the maximum number of times greater 
that the distance between the left peak and middle trough can be than the 
right peak and middle trough, and vice versa. If HorizSymmetryVal is 1.5, 
then the distance between the left peak and the middle trough can be no 
more than 1.5 times the distance of the right peak and middle trough, and 
vice versa, (default =1.5) 
 
 
 

Symmetric Triangle 
 
 

Functions 
 

IdentifyST - Returns an array filled with the following values: 1.0 for a 
pattern in Stage 1, 2.0 for a pattern in Stage 2, 3.0 for a pattern in Stage 3, 
10.0 when the pattern enters Stage 1, and 20.0 when the pattern enters 
Stage 2 from Stage 1. 
STProjection - Returns an array filled with the following values starting 
with the bar in which the pattern enters Stage 2 and stepping backwards: 
the Stage 2 time objective, the Minimum price objective, the Maximum 
price objective, and the value of the neckline. 
STUpperLine - Returns an array filled with the values of the upper 
trendline plus 10% of the height of the third leg at each bar between where 
the pattern entered Stage 1 and where it entered Stage 2. 
STLowerLine - Returns an array filled with the values of the lower 
trendline minus 10% of the height of the third leg at each bar between 
where the pattern entered Stage 1 and where it entered Stage 2. 
 
 
Parameters 

 
ZigZagPercentChange — The value for the Percent Change (if 0 is 
passed in, the value will be calculated dynamically), (default = 0) 
PercentChangeMultiple — Value by which the percent change will be 
multiplied so it has a different value for each iteration through the price 
array, (default = 1.5) 
TrendCalcMethod — Specifies ZigZag method. Linear Slope method, or 
Moving Average method, (default = Z) 
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TrendCalcPeriods — Specifies how many periods should be used to 
determine the current trend, (default = 2 for ZigZag, 13 for LinearSlope or 
MovingAverage) 
TrendCalcSlopeCutoff— Specifies the value for which the slope will be 
considered an uptrend. If the value were .03, for example, then only slopes 
above .03 would be considered an uptrend, (default = .03 for LinearSlope 
method, 0 otherwise) 

TrianglePercentDiff — Specifies the percent that the second peak must 
be lower than the first peak and the first trough must be higher than the 
second trough for which the pattern will still be considered a symmetric 
triangle versus an ascending or descending triangle, (default =10) 
 
 

Ascending/Descending Triangle  
 
 

Functions 
 

Identify AT/IdentifyDTr - Returns an array filled with the following values: 
1.0 for a pattern in Stage 1, 2.0 for a pattern in Stage 2, 3.0 for a pattern in 
Stage 3, 10.0 when the pattern enters Stage 1, and 20.0 when the pattern 
enters Stage 2 from Stage 1. 
ATProjection/DTrProjection - Returns an array filled with the following 
values starting with the bar in which the pattern enters Stage 2 and 
stepping backwards: the Stage 2 time objective, the Minimum price 
objective, the Maximum price objective, and the stop loss value. 
ATTrendline/DTrTrendline - Returns an array filled with the values of the 
trendline plus 10% of the height of the first leg at each bar between where 
the pattern entered Stage 1 and where it entered Stage 2. 
 
 
Parameters 

 
ZigZagPercentChange — The value for the Percent Change (if 0 is ,                    
passed in, the value will be calculated dynamically), (default = 0) 
PercentChangeMultiple — Value by which the percent change will be 
multiplied so it has a different value for each iteration through the price 
array, (default =1.5) 
TrendCalcMethod — Specifies ZigZag method. Linear Slope method, or 
Moving Average method, (default = Z) 
TrendCalcPeriods — Specifies how many periods should be used to 
determine the current trend, (default = 2 for ZigZag, 13 for LinearSlope or 
MovingAverage) 
TrendCalcSlopeCutoff— Specifies the value for which the slope will be 
considered an uptrend. If the value were .03, for example, then only slopes 
above .03 would be considered an uptrend, (default = .03 for LinearSlope 
method, 0 otherwise) 
UpperPercentDiff — For an ascending triangle, the threshold in percent 
within which the value of the second peak must fall. If the 
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UpperPercentDiff was 5% then the value of the second peak would have to 
be within 5% of the value of the first peak. Vice versa for a descending 
triangle, (default = 10) 
LowerPercentDiff— For an ascending triangle, the minimum difference in 
percent, between the first peak and the second peak. Vice versa for a 
descending triangle, (default =10) 
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Troubleshooting 
 
 
 
 
Contacting Equis for Help 

 
 
 

Equis International stands ready to help you with problems you may 
encounter or questions you may have with the operation of MetaStock and 
these tools. However, before picking up the phone, please consider using 
some of Equis'other support alternatives. 
 

Windows Related Problems 
If the problem is related to the Windows operating environment, please 
contact Microsoft technical support at 1-425-635-7000. 
 

User's Manual 
The first place to check when you have a question about the operation of 
MetaStock is in the MetaStock User's Manual (or help system). For questions 
about the operation of the CPR tools, consult this manual. The manuals can be a 
great help if you run into a snag. We have tried to provide every answer you will 
need to operate your software in the pages of your manual. For immediate answers 
to most of your questions, please consult the manual. 
 

On-line Services 
Support is available via email on the Internet (support@equis.com). If you 
have access to email, send us a message. Equis support representatives 
are there to help you and are happy to lend a helping hand or share 
information. 
 

Equis Web Site 
You may also want to check out our site on the Internet's World Wide Web. 
Our URL is http://www.equis.com. Not only do we offer information about 
our products, but we also offer valuable free services and information. 
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Equis User Groups 
 
Equis International has users all over the world. In many of these areas, user 
groups have formed. Contact Equis International to find out if there is an Equis user 
group in your area. Not only is this a great way to meet people with similar 
interests, but these clubs offer a wealth of information and help not available 
elsewhere. 

Contact Equis9 Technical Support 

 
If you've checked the manual and still cannot find the answer to your problem or 
question, Equis International has a full staff of technical support representatives 
ready to help you. 
Please try to call us by phone only if the situation is urgent and you need an 
immediate answer. This will ensure that lines are free when you and others have 
an urgent matter. 

There are several ways to reach our support staff: 
By Internet support@equis.com  

 

By Fax  801-265-2114  

 

By Mail   

Equis International  

Technical Support Dept. 

3950 South 700 East, Suite 100 

Salt Lake City, UT 84107 

 

By Phone 
801-265-9998 (8:00 AM to 5:00 PM Mountain Standard Time except Wednesdays, 
9:00 AM to 5:00 PM) 
 
 
When calling technical support the first time, you will be provided with a customer 
number. 
When you call technical support, it is helpful if you can provide your version 
number and build date. This information is displayed by choosing About 
MetaStock from the Help menu. 
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